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Exploring CAD Integration and 
Associativity

The following exercises illustrate how you can add motion to a model that
has been created in a CAD software package.  You can create CAD
assemblies in such a way that they map into MSC.visualNastran Desktop
very cleanly. When you design assemblies with “motion in mind,” they can
be imported easily and their motion simulated immediately.

In these exercises, you will add motion to an assembly that has been fitted
together with no regard to motion. Although you will have to clean up a few
constraints in the imported CAD model, MSC.visualNastran Desktop makes
it easy to simulate the motion of the assembly.

To complete any of the exercises, you must have one of the following
software installed on your computer in addition to MSC.visualNastran
Desktop:
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• Autodesk® Inventor

• Mechanical Desktop® 

• Pro/ENGINEER®

• Solid EdgeTM 

• SolidWorks®

You can follow the steps in this exercise using any of the supported CAD
packages — Autodesk Inventor, Mechanical Desktop, Pro/ENGINEER,
Solid Edge, or SolidWorks. Go to the section for your CAD package and
follow the steps. Look for the icon that identifies your CAD package.

Exercise 5.1 Exploring Mechanical Desktop Integration 
and Associativity

Objectives In this exercise you will learn to 

• Export a CAD model from Mechanical Desktop.
• Verify and modify your simulation model using the Constraint 

Navigator.
• Change a constraint and add new constraints.
• Use CAD Associativity.
• Organize your design using subassemblies.

Support Files • Tutorials\Chapter 05\Exercise 5.1-MDT\Piston.dwg

Exporting a CAD Model — Mechanical Desktop

1. Launch the Mechanical Desktop program.

Note that a visualNastran menu appears in the Mechanical Desktop menu
bar, as shown in Figure 5-1.
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Figure 5-1
MSC.visualNastran Menu in 
Mechanical Desktop

The Solid Representation menu item displays a dialog that lets you
choose faceted or ACIS geometry. See the online Help for more information
on these choices, but you may ignore them for this exercise. 

A vN toolbar also appears in the Mechanical Desktop window, as shown in
Figure 5-2.

Figure 5-2
vN Toolbar 
in Mechanical Desktop

2. Open the file Piston.dwg located in your Program
Files\MSC.visualNastran Desktop\Tutorials\Chapter 05\Exercise
5.1-MDT folder. 

The CAD model of the piston assembly is displayed as shown in Figure 5-3.

Help
Connect
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Figure 5-3
Mechanical Desktop CAD 
Model of Piston Assembly

3. Choose Units from the MSC.visualNastran menu, and change units to
millimeters. 

This exports the model to scale in MSC.visualNastran Desktop.

4. Choose Connect in the MSC.visualNastran menu, or click the
Gyroscope button in the vN toolbar.

MSC.visualNastran Desktop for Mechanical Desktop prompts you to view a
tutorial overview.  This happens only the very first time you Connect.  When
you dismiss the online tutorial and click again on the gyroscope button,
MSC.visualNastran Desktop for Mechanical Desktop maps the assembly
components and constraints into MSC.visualNastran Desktop bodies and
joints, and creates a new, linked model named Piston.wm3 in the directory
where the CAD files are located. As MSC.visualNastran Desktop translates
the geometry, the progress is displayed in the Preparing Simulation
dialog.

When the export is complete, the MSC.visualNastran Desktop program
opens and displays the CAD Associativity dialog, listing the
MSC.visualNastran Desktop objects that are associated with objects in the
Mechanical Desktop model as shown in Figure 5-4.
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Figure 5-4
CAD Associativity Dialog

 

5. Click OK to close the CAD Associativity dialog.

MSC.visualNastran Desktop prompts you to run the Constraint Navigator. 

6. Click Yes to run the Constraint Navigator.

The linked model appears with the Constraint Navigator in the modeling
window.

Using the Constraint Navigator — Mechanical Desktop
The Constraint Navigator allows you to examine relationships among
bodies, subassemblies, and constraints so that you can verify and modify
your simulation model. The exercise in this section shows you how to use
the Constraint Navigator controls to check your exported model. Refer to
Figure 5-5.

Figure 5-5
Constraint Navigator

Help

Quit
Step Through
Constraints

Step Through
Bodies

Toggle
Wireframe

Move
Object
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When MSC.visualNastran Desktop exports the CAD model, it creates joints
between parts of the assembly. The types of joints created depends on the
constraints and geometry of the CAD model. 

If the joints that MSC.visualNastran Desktop creates are not given the
appropriate degrees of freedom, the parts cannot move appropriately when
you run the simulation. To correct this problem, you should verify and adjust
the joints between the parts of the assembly as necessary to correctly
specify the motion desired.

In the steps that follow, you will adjust the joints to give each the appropriate
degrees of freedom.

1. Click the Next Constraint button.

A revolute joint, constraint[66], is isolated as shown in Figure 5-6.

Figure 5-6
Isolated Constraint

2. Click the Move button in the Constraint Navigator, click over the Crank,
and drag the mouse.

This tests the kind of movement allowed by the constraint. The constraint is
OK.

3. Click the Next Constraint button.

A revolute joint, constraint[68], is isolated.

4. Use the Move tool to test the constraint by first moving the crank and 
then moving the crank pin.

The model requires a rigid connection between CRANKPIN_1 and
CRANK_1.  That means changing this revolute joint into a rigid joint. 

5. Double-click constraint[68] in the Connections List.

The Properties window appears as shown in Figure 5-7.
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Figure 5-7
Properties Window (Constraint 
Page) 

6. Click the Rigid Joint on the Constraint page of the Properties 
window.

7. Under the Rigid tab of the Properties window, accept the Optimized 
setting. 

This combines the mass properties of the two connected bodies and
computes the motion as if they were one body. Unless the constraint force
is to be measured, optimized rigid joints should always be used because
they improve simulation computational speeds.

8. Close the Properties window.

9. Click the Next Constraint button.

A rigid joint on slot, constraint[70], is isolated.

10. Use the Move tool to test the constraint.

This model requires deleting this constraint and its two Coords.

11. Hold down the Control key, and in the Connections List select the two 
Coords connected to constraint[70]. 

The rigid joint, constraint[70], as well as its two Coords, should be selected
when you are done.

12. Press the delete key.

The MSC.visualNastran Desktop dialog appears to inform you that you
are deleting an object linked to a CAD assembly.
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13. Click OK.

14. Click the Next Constraint button.

A revolute joint on slot, constraint[72], is isolated.

15. Use the Move tool to test the constraint.

The model requires changing this constraint to a revolute joint.

16. Double-click constraint[72] in the Connections List.

The Properties window appears. Click the Constraint tab if the Constraint
page is not already displayed. 

17. Select Revolute Joint in the Constraint page of the Properties 
window to change the constraint. 

18. Close the Properties window.

19. Click the Next Constraint button.

A revolute joint, constraint[74], is isolated.

20. Use the Move tool to test the constraint.

The model requires changing this constraint to an optimized rigid joint.

21. Double-click constraint[74] in the Connections List.

The Properties window appears. Click the Constraint tab if the Constraint
page is not already displayed.

22. Select Rigid Joint in the Constraint page of the Properties window.

This changes the constraint.

23. Under the Rigid tab of the Properties window, accept the Optimized 
setting.

24. Close the Properties window.

25. Click the Next Constraint button.

A revolute joint on plane, constraint[76], is isolated.

26. Use the Move tool to test the constraint.

The model requires deleting this constraint and its two Coords.
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27. Hold down the Control key and select in the Connections List the two 
Coords connected to constraint[76].

The revolute joint on plane, constraint[76], as well as its two Coords should
be selected when you are done.

28. Press the delete key.

The MSC.visualNastran Desktop dialog appears to inform you that you
are deleting an object linked to a CAD assembly.

29. Click OK.

30. Click the Next Constraint button.

A revolute joint, constraint[78], is isolated.

31. Use the Move tool to test the constraint.

This constraint is OK.

32. Click the Next Constraint button.

A revolute joint, constraint[80], is isolated.

33. Use the Move tool to test the constraint.

The model requires changing this constraint to an optimized rigid joint.

34. Double-click constraint[80] in the Connections List.

The Properties window appears. Click the Constraint tab if the Constraint
page is not already displayed.

35. Select Rigid Joint in the Constraint page of the Properties window.

This changes the constraint.

36. Under the Rigid tab of the Properties window, accept the Optimized 
setting.

37. Close the Properties window.

38. Click the Next Constraint button.

A revolute joint on plane, constraint[82], is isolated.
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39. Choose Look At from the View menu, then choose Front View from 
the Look At submenu.

This provides a better view of the constraint.

40. Use the Move tool to test the constraint.

The model requires deleting the constraint and its two Coords.

41. Hold down the Control key and select in the Connections List the two 
Coords connected to constraint[82].

The revolute joint on plane, constraint[82], as well as its two Coords should
be selected when you are done.

42. Press the delete key.

The MSC.visualNastran Desktop dialog appears to inform you that you
are deleting an object linked to a CAD assembly.

43. Click OK.

44. Choose Previous View in the View menu.

45. Next, you can step through each body by clicking on the Next and 
Previous Body buttons in the Constraint Navigator to verify body 
motion. 

46. Click Done to close the Constraint Navigator.

Anchored Assemblies — Mechanical Desktop
Based on the constraints and geometry in the Mechanical Desktop CAD
model, MSC.visualNastran Desktop may anchor some parts to the
background when it creates the linked model. The first step in simulating the
motion of the piston assembly is to make sure that it is properly anchored. 

• If no bodies in the assembly are anchored, the piston is floating in
space and gravity will cause it to fall when you run the simulation. 

• If too many bodies are anchored, the piston won’t be able to move
appropriately when you run the simulation.

In this piston assembly, no bodies are anchored.  To prevent the body from
falling due to gravity, we must anchor, or fix, at least one body to the
background.
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1. In the Object List, click the + sign to the left of ANCHOR_1 and select 
ANCHOR.

In the workspace, the anchor appears selected.

2. Right-click the anchor in the piston model and select Fixed from the 
pop-up menu.

The anchor is now fixed to the background.

3. Click the Run button in MSC.visualNastran Desktop’s Tape Player 
Control.

There is no movement. This is because gravity is acting in the “wrong”
direction. By default, gravity acts on the z axis in MSC.visualNastran
Desktop, specifically in the “-z” direction. If the z-axis was not in an upward
orientation when the CAD assembly was created, then the direction of
gravity must be changed before MSC.visualNastran Desktop can properly
simulate the motion.

4. Choose Simulation Settings in the World menu.

The Simulation Settings window appears. 

5. Click Gravity under Simulation Settings in the left pane.

The Gravity page appears as shown in Figure 5-8.

Figure 5-8
Settings Window (Gravity Page) 

6. Click the “-X” direction.
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7. Click Close.

8. Click the Run button in MSC.visualNastran Desktop’s Tape Player 
Control.

MSC.visualNastran Desktop begins to simulate the motion of the model.
The piston assembly balances at first, then the piston head falls under the
effect of gravity. Since the piston is almost in equilibrium, you will not see
any movement at first.   Allow the simulation to run 150 frames.

The geometry of the assembly causes the piston head to swing like a
pendulum around the crank pin, which is held in place by the anchor, as
shown in Figure 5-9. 

Figure 5-9
Piston Head Swinging Around 
the Crank Pin Like a Pendulum 

Since this is the first time the simulation is being run, MSC.visualNastran
Desktop calculates the dynamics and stores the data. 

9. Repeat the simulation by clicking the Stop button, then the Reset
button, and then the Run button again.

Depending on the speed of your computer, the animation may be faster this
time because the history has already been calculated.

Adding a Motor — Mechanical Desktop
Currently, the piston assembly is moving only in response to the effects of
gravity. In this step, you will change the joint between the anchor and left
side of the crank to a motor to simulate the force that drives the motion of
the piston. 
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1. In the Object List, click the + sign to the left of ANCHOR_1  and select 
ANCHOR.

The Connections List displays a list of the objects connected to this body.

2. Double-click constraint[66], the revolute joint that connects ANCHOR 
to CRANK.

The Properties window for constraint [66] appears.

3. If necessary, click the Constraint tab in the Properties window. Then,
select Revolute Motor for the list of available joint types, as shown in
Figure 5-10.

The revolute joint is changed into a revolute motor. 

Figure 5-10
Properties Window 
(Constraint Page) for Revolute 
Motor

4. Click the Motor tab in the Properties window.

This brings up the motor characteristics page.

5. Accept Angular Velocity in the list of Motor Types.

6. Enter 500 as the value for angular velocity of this Revolute Motor, as 
shown in Figure 5-11.

You can close the Properties window now.
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Figure 5-11
Properties WIndow 
(Motor Page)

7. Click the Run button in MSC.visualNastran Desktop’s Tape Player 
Control.

The piston assembly rotates all the way around the crank pin, as shown in
Figure 5-12. It no longer swings like a pendulum, because the motor
provides the driving force to keep the piston rotating. 

Figure 5-12
Piston Head Rotating All the 
Way Around the Crank Pin 

8. Click the Stop button.

Adjusting the Joints — Mechanical Desktop
In this step, you will add a new constraint that limits the motion of the piston
head, so that it can only move vertically.

1. Reset the simulation by clicking the Reset button.

The piston assembly returns to its starting position.
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2. Press “X” on the keyboard, or choose Look At in the View menu and 
choose Front View in the submenu. 

3. Click the Rotate Around tool in the View toolbar and rotate the model 
so that you can see the top of the piston head and the rest of the 
drawing.

Your view should be similar to Figure 5-13. 

Figure 5-13
Top of the Piston Head

4. Click the Coord tool in the Edit toolbar, then place a Coord on the top 
surface of the piston head, near the center.

Blue lines appear around the piston head and cranks. This feature
recognition helps guide placement of the Coord. When you place the Coord
on the blue circular outline on top of the piston head, it automatically snaps
to the center of the piston head. The z-axis of the Coord should point
upward and its red outline surrounds the top center of the piston head.

5. Make sure that the Coord that you just created is selected.  Then click
the Join/Create Constraint button in the Edit toolbar.

The Create Constraint window appears.

6. Select Rigid Joint on Slot from the list of available constraint types,
as shown in Figure 5-14.  Then click Create.

A rigid joint on slot appears on top of the piston head. This constraint
connects the piston head to the background and allows the piston head to
move only in the vertical direction. 
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Figure 5-14
Create Constraint Window

 

7. Choose Go Home in the View menu.

Your original view of the piston assembly (which provides a better view of
the motion) is restored. 

8. Click the Run button in MSC.visualNastran Desktop’s Tape Player 
Control.

The piston head is pushed up and pulled down by the connecting rod as the
crank rotates about the crank pin, as shown in Figure 5-15.

Figure 5-15
Piston Head Pushed Up and 
Pulled Down by the Connecting 
Rod

9. Click the Stop button.

Your model of the motion of the piston assembly is now complete!
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Using CAD Associativity — Mechanical Desktop
You’ve put a lot of work into adapting the CAD model to accurately simulate
the motion of the piston assembly. What happens if the CAD model
changes? 

When you re-export the CAD model, any changes made to it in Mechanical
Desktop are automatically incorporated into your simulation of the motion.
All of the changes and enhancements that you have already made in the
simulation are left unchanged. 

Change the Connecting Rod 
Length and Re-export the 
CAD Model

In this step, you will make changes to the CAD model in Mechanical
Desktop and re-export the model to MSC.visualNastran Desktop. When you
return to MSC.visualNastran Desktop, the changes you made will
automatically be incorporated into your simulation of the motion.

1. Reopen the Piston model in your CAD software.

2. Change the length of the Connecting Rod part from 150 mm to 250 
mm.

If needed, refer to your CAD software User’s Manual or online help for
instructions on how to change the length of the connecting rod part.

3. Choose Connect in the MSC.visualNastran menu.

MSC.visualNastran Desktop for Mechanical Desktop re-exports the piston
assembly components and constraints. When the process is done, the
MSC.visualNastran Desktop program reopens the linked model, as shown
in Figure 5-16.
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Figure 5-16
Changes in the Mechanical 
Desktop CAD Model Reflected 
in MSC.visualNastran Desktop 

Your changes to the CAD model are reflected in MSC.visualNastran
Desktop. The length of the connecting rod has been changed.

4. Click the Run button in MSC.visualNastran Desktop’s Tape Player 
Control.

Your simulation of the motion of the piston assembly runs with no problems.

5. Click the Stop button.

MSC.visualNastran Desktop preserves and protects your enhancements to
the simulation model, while giving you the flexibility to change the
underlying geometry of the CAD model as needed.

Using Sub-Assemblies — Mechanical Desktop
You can use MSC.visualNastran Desktop’s sub-assembly feature to help
organize your design.

1. Choose Sub-assembly in the Insert menu.

The Create Sub-assembly dialog appears.

2. Enter Crank Parts in the text region of the Sub-assembly dialog and 
click OK.

The Crank Parts sub-assembly is added to the Object List.
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3. In the Object List, drag and drop the Anchor, both Cranks, and the 
Crank Pin into the sub-assembly.

The drawing is unchanged by the re-organized Object List.

Exercise 5.2 Exploring Pro/ENGINEER Integration and 
Associativity

Objectives In this exercise you will learn to 

• Export a CAD model from Pro/Engineer.
• Verify and modify your simulation model using the Constraint 

Navigator.
• Change a constraint to a motor and add new constraints.
• Use CAD Associativity.
• Organize your design using subassemblies.

Support Files • Tutorials\Chapter 5\Exercise 5.2-ProE\Piston.asm

Exporting a CAD Model — Pro/ENGINEER

1. Launch Pro/ENGINEER.

For Pro/ENGINEER versions 20 and above, a visualNastran menu item
will appear in the part or assembly menus as appropriate; for earlier
versions, the item will also appear in the Main menu as shown in Figure 5-
17.
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Figure 5-17
MSC.visualNastran menu
in Pro/ENGINEER

Figure 5-18
MSC.visualNastran Submenu 
in 
Pro/ENGINEER

For more information on Geometry and Quality settings, see the online
Help. You may ignore these choices for this exercise.

2. Open the file piston.asm located in your Program 
Files\visualNastran Desktop\Tutorials\Chapter 05\Exercise 5.2-
ProE folder. 

The CAD model of the piston assembly is displayed as shown in Figure 5-
19.

visualNastran 
for Pro/ENGINEER

visualNastran submenu 
for Pro/ENGINEER
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Figure 5-19
Pro/ENGINEER CAD Model 
of Piston Assembly

3. Choose Connect in thevisualNastran submenu.

MSC.visualNastran Desktop for Pro/ENGINEER may prompt you to view a
tutorial overview.  This happens only the very first time you Connect.  When
you close the online tutorial and choose Connect again, MSC.visualNastran
Desktop for Pro/ENGINEER maps the assembly components and
constraints into MSC.visualNastran Desktop bodies and joints, and creates
a new, linked model named Piston.wm3 in the directory where the CAD
files are located.

When the export is complete, the MSC.visualNastran Desktop program
opens and displays the CAD Associativity dialog, listing the
MSC.visualNastran Desktop objects that are associated with objects in the
Pro/ENGINEER model as shown in Figure 5-20.
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Figure 5-20
CAD Associativity Dialog

 

4. Click OK to close the CAD Associativity dialog.

MSC.visualNastran Desktop prompts you to run the Constraint Navigator. 

5. Click Yes to run the Constraint Navigator.

The linked model and the Constraint Navigator appear in the modeling
window.

6. Click the Rotate button and rotate the piston to a vertical orientation.

Using the Constraint Navigator — Pro/ENGINEER
The Constraint Navigator allows you to examine relationships among
bodies, subassemblies, and constraints so that you can verify and modify
your simulation model. The exercise in this section shows you how to use
the Constraint Navigator controls to check your exported model. Refer to
Figure 5-21.

Figure 5-21
Constraint Navigator

Help
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When MSC.visualNastran Desktop exports the CAD model, it creates joints
between parts of the assembly. The types of joints created depends on the
constraints and geometry of the CAD model. 

If the joints that MSC.visualNastran Desktop creates are not given the
appropriate degrees of freedom, the parts cannot move appropriately when
you run the simulation. To correct this problem, you should verify and adjust
the joints between the parts of the assembly as necessary to correctly
specify the motion desired.

In the steps that follow, you will adjust the joints to give each the appropriate
degrees of freedom.

1. Click the Next Constraint button.

A revolute joint, constraint[46], is isolated as shown in Figure 5-22.

Figure 5-22
Isolated Constraint

2. Click the Move button in the Constraint Navigator, click over the 
Crank, and drag the mouse.

This tests the kind of movement allowed by the constraint. This constraint
is OK.

3. Click the Next Constraint button.

A revolute joint, constraint[50], is isolated.

4. Use the Move tool to test the constraint by moving the crank and then 
moving the crank pin.

The model requires a rigid connection between CRANK_PIN and CRANK.
That means changing this revolute joint into a rigid joint. 

5. Double-click constraint[50] in the Object List.

The Properties window appears as shown in Figure 5-23. Click the
Constraint tab if the Constraint page is not already displayed.
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Figure 5-23
Properties Window (Constraint 
Page) 

6. Click the Rigid Joint on the Constraint page of the Properties window.

7. Under the Rigid tab of the Properties window, accept the Optimized 
setting. 

This combines the mass properties of the two connected bodies and
computes the motion as if they were one body. Unless the constraint force
is to be measured, optimized rigid joints should always be used because
they improve simulation compute speeds.

8. Close the Properties window.

9. Click the Next Constraint button.

A rigid joint on slot, constraint[52], is isolated.

10. Use the Move tool to test the constraint.

The model requires deleting this constraint and the two Coords attached to
it.

11. Hold down the Control key and select in the Connections List 
coord[24] on CONNECTING_ROD and coord[26] on CRANK, the 
two Coords connected to constraint[52].

The rigid joint on slot, constraint[52], as well as its two Coords should be
selected when you are done.

12. Press the delete key.

The MSC.visualNastran Desktop dialog appears to inform you that you
are deleting an object linked to a CAD assembly.
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13. Click OK.

14. Click the Next Constraint button.

A revolute joint on slot, constraint[54], is isolated.

15.  Use the Move tool to test the constraint.

The model requires changing this constraint to a revolute joint.

16. Double-click constraint[54] in the Connections List.

The Properties window appears. Click the Constraint tab if the Constraint
page is not already displayed. 

17. Select Revolute Joint in the Constraint page of the Properties 
window.

This changes the constraint.

18. Close the Properties window.

19. Click the Next Constraint button.

A revolute joint, constraint[56], is isolated.

20.  Use the Move tool to test the constraint.

The model calls for an optimized rigid joint here.

21. Double-click constraint[56].

The Properties window appears.

22. Click Rigid Joint on the Constraint page of the Properties window.

23. Under the Rigid tab of the Properties window, accept the Optimized 
setting.

24. Close the Properties window.

25. Click the Next Constraint button.

A revolute joint on plane, constraint[58], is isolated.

26.  Use the Move tool to test the constraint.

The model requires deleting this constraint and the two Coords attached to
it.
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27. Hold down the Control key and select in the Connections List 
coord[39] on Crank_2 and coord[40] on Crank, the two Coords 
connected to constraint[58].

The revolute joint on plane, constraint[58], as well as its Coords, should be
selected when you are done.

28. Press the delete key.

The MSC.visualNastran Desktop dialog appears to inform you that you
are deleting an object linked to a CAD assembly.

29. Click OK.

30. Click the Next Constraint button.

A revolute joint, constraint[60], is isolated.

31.  Use the Move tool to test the constraint.

This joint is OK.

32. Click the Next Constraint button.

A revolute joint, constraint[62], is isolated.

33.  Use the Move tool to test the constraint.

The model requires changing this to an optimized rigid joint.

34. Double-click constraint[62].

The Properties window appears.

35. Click Rigid Joint on the Constraint page of the Properties window.

36. Under the Rigid tab of the Properties window, accept the Optimized 
setting.

37. Close the Properties window.

38. Next, you can step through each body by clicking on the Next and 
Previous Body buttons in the Constraint Navigator to verify body 
motion.

39. Close the Constraint Navigator.
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Anchored Assemblies — Pro/ENGINEER
Based on the constraints and geometry in the Pro/ENGINEER CAD model,
MSC.visualNastran Desktop may anchor some parts to the background
when it creates the linked model. The first step in simulating the motion of
the piston assembly is to make sure that it is properly anchored. 

• If no bodies in the assembly are anchored, the piston is floating in
space and gravity will cause it to fall when you run the simulation. 

• If too many bodies are anchored, the piston won’t be able to move
appropriately when you run the simulation.

When MSC.visualNastran Desktop imports the piston assembly from Pro/
ENGINEER, it doesn’t anchor any bodies.

In order for the piston to move properly, you must anchor the body named
ANCHOR to the background. 

1. Double-click ANCHOR in the Object List.

The Properties window for ANCHOR appears.

2. If necessary, click the Pos tab in the Properties window, then click the 
Fixed (Anchored) box to put a check mark in it, as shown in Figure 5-
24.

Figure 5-24
Properties Window 
(Position Page) for the Anchor

3. Click the Run button in MSC.visualNastran Desktop’s Tape Player 
Control, and let the simulation run for about 200 frames.

MSC.visualNastran Desktop begins to simulate the motion of the model.
The piston assembly balances at first, then the piston head falls under the
effect of gravity. Since the piston is almost in equilibrium, you will not see
any movement at first. 

Check this box
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The geometry of the assembly causes the piston head to swing like a
pendulum around the crank pin, which is held in place by the anchor, as
shown in Figure 5-25. 

Figure 5-25
Piston Head Swinging Around 
the Crank Pin Like a Pendulum 

Since this is the first time the simulation is being run, MSC.visualNastran
Desktop calculates the dynamics and stores the data. 

4. Repeat the simulation by clicking the Stop button, then the Reset 
button, and then the Run button again.

Depending on the speed of your computer, the animation may be faster this
time because the history has already been calculated.

Adding a Motor — Pro/ENGINEER
Currently, the piston assembly is moving only in response to the effects of
gravity. In this step, you will change the joint between the anchor and left
side of the crank to a motor to simulate the force that drives the motion of
the piston. 

1. Select ANCHOR in the Object List.

The Connections List displays a list of the objects connected to this body.

2. Double-click constraint[46], the revolute joint that connects ANCHOR 
to CRANK.

The Properties window for constraint[46] appears.
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3. If necessary, click the Constraint tab in the Properties window. Then,
select Revolute Motor from the list of available joint types, as shown
in Figure 5-26.

The revolute joint is changed into a revolute motor. The Motor page of the
Properties window appears.

Figure 5-26
Properties Window 
(Constraint Page) for Revolute 
Motor

4. Click the Motor tab.

This displays the Motor page of the Properties window.

5. Accept Angular Velocity in the list of Motor Types.

6. Enter 500 as the value for angular velocity of this Revolute Motor, as 
shown in Figure 5-27.

You can close the Properties window now.

Figure 5-27
Properties WIndow 
(Motor Page)

7. Click the Run button in MSC.visualNastran Desktop’s Tape Player 
Control.
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The piston assembly rotates all the way around the crank pin, as shown in
Figure 5-28. It no longer swings like a pendulum, because the motor
provides the driving force to keep the piston rotating. 

Figure 5-28
Piston Head Rotating All the 
Way Around the Crank Pin 

8. Click the Stop button.

Adjusting the Joints — Pro/ENGINEER
In this step, you will add a new constraint that limits the motion of the piston
head, so that it can only move vertically.

1. Reset the simulation by clicking the Reset button.

The piston assembly returns to its starting position.

2. Press “Z” on the keyboard, or choose Look At in the View menu and 
choose Top View in the submenu. 

3. Click the Rotate Around tool in the View toolbar or press “T” on the 
keyboard so that you can see the top of the piston head and the rest of 
the drawing.

Your view should be similar to Figure 5-29. 
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Figure 5-29
Top of the Piston Head

4. Click the Coord tool in the Sketch toolbar, then place a Coord on the 
top surface of the piston head, near the center.

Blue lines appear around the piston head and cranks. This feature
recognition helps guide placement of the Coord. When you place the Coord,
it automatically snaps to the center of the piston head. The z-axis of the
Coord should point upward and its red outline surrounds the top center of
the piston head.

5. Make sure the Coord that you just created is selected.  Then click the 
Join/Create Constraint button in the Edit toolbar.

The Create Constraint window appears.

6. Select Rigid Joint on Slot from the list of available constraint types, 
as shown in Figure 5-30, and click Create.

A rigid joint on slot appears on top of the piston head. This constraint
connects the piston head to the background and allows the piston head to
move only in the vertical (z-axis) direction. 
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Figure 5-30
Create Constraint Window

 

7. Choose Go Home in the View menu.

Your original view of the piston assembly (which provides a better view of
the motion) is restored. 

8. Click the Run button in MSC.visualNastran Desktop’s Tape Player 
Control.

The piston head is pushed up and pulled down by the connecting rod as the
crank rotates about the crank pin, as shown in Figure 5-31.

Figure 5-31
Piston Head Pushed Up and 
Pulled Down by the Connecting 
Rod

9. Click the Stop button.

Your model of the motion of the piston assembly is now complete!
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Using CAD Associativity — Pro/ENGINEER
You’ve put a lot of work into adapting the CAD model to accurately simulate
the motion of the piston assembly. What happens if the CAD model
changes? 

When you re-export the CAD model, any changes to it are automatically
incorporated into your simulation of the motion. All of the changes and
enhancements that you have already made in the simulation are left
unchanged. 

Change the Connecting Rod 
Length and Re-export the 
CAD Model

In this step, you will re-export the model to MSC.visualNastran Desktop.
When you return to MSC.visualNastran Desktop, the changes you made will
automatically be incorporated into your simulation of the motion.

1. Reopen the Piston model in your CAD software.

2. Change the length of the Connecting Rod part from 150 mm to 250 
mm.

If needed, refer to your CAD software User’s Manual or online help for
instructions on how to change the length of the connecting rod part.

3. Choose Connect in the MSC.visualNastran submenu.

MSC.visualNastran Desktop for Pro/ENGINEER re-exports the piston
assembly components and constraints. When the process is done, the
MSC.visualNastran Desktop program reopens the linked model, as shown
in Figure 5-32.
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Figure 5-32
Changes in the Pro/ENGINEER 
CAD Model Reflected in 
MSC.visualNastran Desktop 

Your changes to the CAD model are reflected in MSC.visualNastran
Desktop. The length of the connecting rod has been changed.

4. Click the Run button in MSC.visualNastran Desktop’s Tape Player
Control.

The piston assembly simulation runs with no problems.

5. Click the Stop button.

MSC.visualNastran Desktop preserves and protects your enhancements to
the simulation model, while giving you the flexibility to change the
underlying geometry of the CAD model as needed.

Using Sub-Assemblies — Pro/ENGINEER
You can use MSC.visualNastran Desktop’s sub-assembly feature to help
organize your design.

1. Choose Sub-assembly in the Insert menu.

The Create Sub-assembly dialog appears.

2. Enter Crank Parts in the text region of the Sub-assembly dialog.

The Crank Parts sub-assembly is added to the Object List.
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3. In the Object List, drag and drop the Anchor, both Cranks, and the
Crank Pin into the sub-assembly.

The drawing is unchanged by the re-organized Object List.

Exercise 5.3 Exploring Solid Edge Integration and 
Associativity

Objectives In this exercise you will learn to 

• Export a CAD model from Solid Edge.
• Verify and modify your simulation model using the Constraint 

Navigator.
• Change a constraint to a motor and add new constraints.
• Use CAD Associativity.
• Organize your design using subassemblies.

Support Files • Tutorials\Chapter 05\Exercise 5.3-Solid Edge\Piston.asm

Exporting a CAD Model — Solid Edge

NOTE: To activate the MSC.visualNastran Desktop toolbar in Solid Edge, 
you must install MSC.visualNastran Desktop for Solid Edge and then launch 
it from the Start menu as follows: Start->Programs->visualNastran 
Desktop->Solid Edge Integration. You need to perform this procedure 
only once.

1. Launch the Solid Edge Assembly program.

Note that the MSC.visualNastran Desktop toolbar appears at the left edge
of the Solid Edge window, as shown in Figure 5-33.
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Figure 5-33
MSC.visualNastran Desktop 
Toolbar in Solid Edge

2. Open the file Piston.asm located in your Program
Files\visualNastran Desktop\Tutorials\Chapter 05\Exercise 5.3-
Solid Edge folder. 

The CAD model of the piston assembly is displayed as shown in Figure 5-
34.

Figure 5-34
Solid Edge CAD Model 
of Piston Assembly

3. Click the Gyroscope button in the MSC.visualNastran Desktop
toolbar.

MSC.visualNastran Desktop for Solid Edge may prompt you to view a
tutorial overview.  (This happens only the very first time you Connect.)
When you dismiss the online tutorial and click again on the gyroscope
button, the visualNastran for Solid Edge dialog appears, as shown in
Figure 5-35.

MSC.visualNastran Desktop 

Help

for Solid Edge
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Figure 5-35
visualNastran for Solid Edge 
Dialog

Note that the dialog allows you to select faceted geometry. The default is
ACIS.  See the online Help for more information on these choices, but you
may ignore them for this exercise.

4. Click the Build Model button.

MSC.visualNastran Desktop for Solid Edge maps the assembly
components and constraints into MSC.visualNastran Desktop bodies and
joints, and creates a new, linked model named Piston.wm3 in the directory
where the CAD files are located. As MSC.visualNastran Desktop translates
the geometry, the progress is displayed in the visualNastran for Solid
Edge dialog.

When the export is complete, the MSC.visualNastran Desktop program
opens and displays the CAD Associativity dialog, listing the
MSC.visualNastran Desktop objects that are associated with objects in the
Solid Edge model as shown in Figure 5-36.

Figure 5-36
CAD Associativity Dialog
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5. Click OK to close the CAD Associativity dialog.

MSC.visualNastran Desktop prompts you to run the Constraint Navigator. 

6. Click Yes to run the Constraint Navigator.

The linked model and the Constraint Navigator appear in the modeling
window.

Using the Constraint Navigator — Solid Edge
The Constraint Navigator allows you to examine relationships among
bodies, subassemblies, and constraints so that you can verify and modify
your simulation model. The exercise in this section shows you how to use
the Constraint Navigator controls to check your exported model. Refer to
Figure 5-37.

Figure 5-37
Constraint Navigator

When MSC.visualNastran Desktop exports the CAD model, it creates joints
between parts of the assembly. The types of joints created depends on the
constraints and geometry of the CAD model. 

If the joints that MSC.visualNastran Desktop creates are not given the
appropriate degrees of freedom, the parts cannot move appropriately when
you run the simulation. To correct this problem, you should verify and adjust
the joints between the parts of the assembly as necessary to correctly
specify the motion desired.

In the steps below, you will adjust the joints to give each the appropriate
degrees of freedom.

1. Click the Next Constraint button.

A revolute joint, constraint[44], is isolated as shown in Figure 5-38.

Help

Quit
Step Through
Constraints

Step Through
Bodies

Toggle
Wireframe

Move
Object
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Figure 5-38
Isolated Constraint

2. Click the Move button in the Constraint Navigator, click over the Crank, 
and drag the mouse.

This tests the kind of movement allowed by the constraint. The constraint is
OK.

3. Click the Next Constraint button.

A revolute joint, constraint[46], is isolated.

4. Use the Move tool to test the constraint by first moving the crank and 
then moving the crank pin.

The model requires a rigid connection between Crank Pin.par:1 and
Crank.par:1.  That means changing this revolute joint into a rigid joint. 

5. Double-click constraint[46] in the Connections List.

The Properties window appears as shown in Figure 5-39.

Figure 5-39
Properties Window (Constraint 
Page) 

6. Select Rigid Joint on the Constraint page of the Properties window.

7. Under the Rigid tab of the Properties window, accept the Optimized 
setting. 
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This combines the mass properties of the two connected bodies and
computes the motion as if they were one body. Unless the constraint force
is to be measured, optimized rigid joints should always be used because
they improve simulation computational speeds.

8. Close the Properties window.

9. Click the Next Constraint button.

A revolute joint, constraint[48], is isolated.

10. Use the Move tool to move the crank.

This model requires changing this constraint to an optimized rigid joint.

11. Double-click constraint[48] in the Connections List.

The Properties window appears. Click the Constraint tab if the Constraint
page is not already displayed.

12. Select Rigid Joint in the Constraint page of the Properties window.

This changes the constraint.

13. Close the Properties window.

14. Click the Next Constraint button.

A parallel joint, constraint[50], is isolated.

15. Use the Move tool to move the two cranks.

The model requires deleting this constraint and its two Coords.

16. Hold down the Control key and select in the Connections List 
coord[28] on Crank.par:2 and coord[30] on Crank.par:1, the two 
Coords connected to constraint[50].

The two coords connected to the parallel joint, constraint[50], should be
selected when you are done.

17. Press the delete key.

The MSC.visualNastran Desktop dialog appears to inform you that you
are deleting an object linked to a CAD assembly.

18. Click OK.
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19. Click the Next Constraint button.

A revolute joint, constraint[52], is isolated.  (You may have to click the Next
constraint button several times to reach constraint[52].)

20. Use the Move tool to test the constraint.

This constraint is OK.

21. Click the Next Constraint button.

A revolute joint, constraint[54], is isolated.

22. Use the Move tool to test the constraint.

This constraint is OK.

23. Click the Next Constraint button.

A revolute joint, constraint[56], is isolated.

24. Use the Move tool to move the piston head.

The model requires changing this constraint to an optimized rigid joint.

25. Double-click constraint[56] in the Connections List.

The Properties window appears. Click the Constraint tab if the Constraint
page is not already displayed.

26. Select Rigid Joint in the Constraint page of the Properties window.

This changes the constraint.

27. Next, you can step through each body by clicking on the Next and
Previous Body buttons in the Constraint Navigator to verify body
motion. 

28. Close the Constraint Navigator and press the Esc key to return to the
Select tool.

Anchored Assemblies — Solid Edge
Based on the constraints and geometry in the Solid Edge CAD model,
MSC.visualNastran Desktop may anchor some parts to the background
when it creates the linked model. The first step in simulating the motion of
the piston assembly is to make sure that it is properly anchored. 



5-42 Chapter 5—Exploring CAD Integration and Associativity
• If no bodies in the assembly are anchored, the piston is floating in
space and gravity will cause it to fall when you run the simulation. 

• If too many bodies are anchored, the piston won’t be able to move
appropriately when you run the simulation. 

When MSC.visualNastran Desktop imports the piston assembly from Solid
Edge, it anchors the body named Anchor.par:1.

1. Look at the Object List and note any bodies that have an anchor
symbol attached to their icons.

One body in the linked model, Anchor.par:1, is anchored (fixed) by
MSC.visualNastran Desktop.

2. Click the Run button in MSC.visualNastran Desktop’s Tape Player 
Control, and let the simulation run for about 100 frames.

MSC.visualNastran Desktop begins to simulate the motion of the model.
The piston assembly balances at first, then the piston head falls under the
effect of gravity. Since the piston is almost in equilibrium, you will not see
any movement at first. 

The geometry of the assembly causes the piston head to swing like a
pendulum around the crank pin, which is held in place by the anchor, as
shown in Figure 5-40. 

Figure 5-40
Piston Head Swinging Around 
the Crank Pin Like a Pendulum 

Since this is the first time the simulation is being run, MSC.visualNastran
Desktop calculates the dynamics and stores the data. 
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3. Repeat the simulation by clicking the Stop button, then the Reset
button, and then the Run button again.

Depending on the speed of your computer, the animation may be faster this
time because the history has already been calculated.

Adding a Motor — Solid Edge
Currently, the piston assembly is moving only in response to the effects of
gravity. In this step, you will change the joint between the anchor and left
side of the crank to a motor to simulate the force that drives the motion of
the piston.

1. Select Anchor.par:1 in the Object List.

The Connections List displays a list of the objects connected to this body.

2. Double-click constraint[44], the revolute joint that connects
Anchor.par:1 to Crank.par:1.

The Properties window for constraint [44] appears.

3. If necessary, click the Constraint tab in the Properties window. Then,
select Revolute Motor from the list of available joint types, as shown
in Figure 5-41.

The revolute joint is changed into a revolute motor. 

Figure 5-41
Properties Window 
(Constraint Page) for Revolute 
Motor

4. Click the Motor tab.

The Motor page of the Properties window appears.

5. Accept Angular Velocity in the list of Motor Types.

6. Enter 500 as the value for angular velocity of this Revolute Motor, as 
shown in Figure 5-42.
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You can close the Properties window now.

Figure 5-42
Properties Window 
(Motor Page)

7. Click the Run button in MSC.visualNastran Desktop’s Tape Player 
Control.

The piston assembly rotates all the way around the crank pin, as shown in
Figure 5-43. It no longer swings like a pendulum, because the motor
provides the driving torque to keep the piston rotating. 

Figure 5-43
Piston Head Rotating All the 
Way Around the Crank Pin 

8. Click the Stop button.

Adjusting the Joints — Solid Edge
In this step, you will add a new constraint that limits the motion of the piston
head, so that it can only move vertically.

1. Reset the simulation by clicking the Reset button.
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The piston assembly returns to its starting position. 

2. Click the Rotate Around tool in the View toolbar or press “T” on the 
keyboard so that you can see the top of the piston head and the rest of 
the drawing.

Your view should be similar to Figure 5-44. 

Figure 5-44
Top of the Piston Head

3. Click the Coord tool in the Edit toolbar, then place a Coord on the top 
surface of the piston head, near the center.

Blue lines appear around the piston head and cranks. This feature
recognition helps guide placement of the Coord. When you place the Coord,
it automatically snaps to the center of the piston head. The z-axis of the
Coord should point upward and its red outline surrounds the top center of
the piston head.

4. Make sure the Coord that you just created is selected.  Then click the 
Join/Create Constraint button in the Edit toolbar.

The Create Constraint window appears.

5. Select Rigid Joint on Slot from the list of available constraint types, 
as shown in Figure 5-45, and click Create.

A rigid joint on slot appears on top of the piston head. This constraint
connects the piston head to the background and allows the piston head to
move only in the vertical (z-axis) direction. 
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Figure 5-45
Create Constraint Window

 

6. Choose Go Home in the View menu.

Your original view of the piston assembly (which provides a better view of
the motion) is restored. 

7. Click the Run button in MSC.visualNastran Desktop’s Tape Player 
Control.

The piston head is pushed up and pulled down by the connecting rod as the
crank rotates about the crank pin, as shown in Figure 5-46.

Figure 5-46
Piston Head Pushed Up and 
Pulled Down by the Connecting 
Rod

8. Click the Stop button.

Your model of the motion of the piston assembly is now complete!
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Using CAD Associativity — Solid Edge
You’ve put a lot of work into adapting the CAD model to accurately simulate
the motion of the piston assembly. What happens if the CAD model
changes? 

When you re-export the CAD model, any changes to it are automatically
incorporated into your simulation of the motion. All of the changes and
enhancements that you have already made in the simulation are left
unchanged. 

Change the Connecting Rod 
Length and Re-export the 
CAD Model

In this step, you will re-export the model to MSC.visualNastran Desktop.
When you return to MSC.visualNastran Desktop, the changes you made will
automatically be incorporated into your simulation of the motion.

1. Reopen the Piston model in your CAD software.

2. Change the length of the Connecting Rod part from 150 mm to 250 
mm.

If needed, refer to your CAD software User’s Manual or online help for
instructions on how to change the length of the connecting rod part.

3. Save your changes to the Connecting Rod part.

Solid Edge requires you to save your changes before you can re-export the
model to MSC.visualNastran Desktop.

4. Click the Gyroscope button in the MSC.visualNastran Desktop 
toolbar.

The visualNastran for Solid Edge dialog appears, as shown in Figure 5-
47.

Figure 5-47
visualNastran for Solid Edge 
Dialog

5. Click the Build Model button.
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MSC.visualNastran Desktop for Solid Edge re-exports the piston assembly
components and constraints. When the process is done, the
MSC.visualNastran Desktop program reopens the linked model, as shown
in Figure 5-48.

Figure 5-48
Changes in the Solid Edge CAD 
Model Reflected in 
MSC.visualNastran Desktop

Your changes to the CAD model are reflected in MSC.visualNastran
Desktop. The length of the connecting rod has been changed.

6. Click the Run button in MSC.visualNastran Desktop’s Tape Player 
Control.

Your simulation of the motion of the piston assembly runs with no problems.

7. Click the Stop button.

MSC.visualNastran Desktop preserves and protects your enhancements to
the simulation model, while giving you the flexibility to change the
underlying geometry of the CAD model as needed.

Using Sub-Assemblies — Solid Edge
You can use MSC.visualNastran Desktop’s sub-assembly feature to help
organize your design.

1. Choose Sub-assembly in the Insert menu.
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The Create Sub-assembly dialog appears.

2. Enter Crank Parts in the text region of the Sub-assembly dialog.

The Crank Parts sub-assembly is added to the Object List.

3. In the Object List, drag and drop the Anchor, both Cranks, and the
Crank Pin into the sub-assembly.

The drawing is unchanged by the re-organized Object List.

 Exercise 5.4 Exploring SolidWorks Integration and 
Associativity

Objectives In this exercise you will learn to 

• Export a CAD model from SolidWorks.
• Verify and modify your simulation model using the Constraint

Navigator.
• Change a constraint to a motor and add new constraints.
• Use CAD Associativity.
• Organize your design using subassemblies.

Support Files • Tutorials\Chapter 05\Exercise 5.5-SolidWorks\Piston.sldasm

Exporting a CAD Model — SolidWorks
To activate MSC.visualNastran Desktop for SolidWorks, you need to enable
it using the SolidWorks Add-Ins feature.

NOTE: You need to perform this procedure once after installing 
MSC.visualNastran Desktop for SolidWorks.

• Launch the SolidWorks program.

• Choose Add-Ins... in the SolidWorks Tools menu.

• Check the visualNastran checkbox.

1. Launch the SolidWorks program.
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2. Open the file Piston.sldasm located in your Program 
Files\visualNastran Desktop\Tutorials\Chapter 05\Exercise 5.4-
SolidWorks folder.

Note that an MSC.visualNastran menu appears in the SolidWorks menu
bar, as shown in Figure 5-49.

Figure 5-49
MSC.visualNastran menu
in SolidWorks

The menu allows you to select true or faceted geometry. The default is
faceted. See the Online Help for more information on these choices, but you
may ignore them for this exercise.

The CAD model of the piston assembly is displayed as shown in Figure 5-
50.

Figure 5-50
SolidWorks CAD Model 
of Piston Assembly
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3. Choose Connect in the MSC.visualNastran menu.

MSC.visualNastran Desktop for SolidWorks may prompt you to view a
tutorial overview.  This happens only the very first time you Connect.  When
you dismiss the online tutorial and choose Connect again,
MSC.visualNastran Desktop for SolidWorks maps the assembly
components and constraints into MSC.visualNastran Desktop bodies and
joints, and creates a new, linked model named Piston.wm3 in the directory
where the CAD files are located. As MSC.visualNastran Desktop translates
the geometry, the progress is displayed in the Preparing Simulation
dialog. 

When the export is complete, the MSC.visualNastran Desktop program
opens and displays the CAD Associativity dialog, listing the
MSC.visualNastran Desktop objects that are associated with objects in the
SolidWorks model as shown in Figure 5-51.

Figure 5-51
CAD Associativity Dialog

 

4. Click OK to close the CAD Associativity dialog.

MSC.visualNastran Desktop prompts you to run the Constraint Navigator. 

5. Click Yes to run the Constraint Navigator.

The linked model and the Constraint Navigator appear in the modeling
window.
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Using the Constraint Navigator — SolidWorks
The Constraint Navigator allows you to examine relationships among
bodies, subassemblies, and constraints so that you can verify and modify
your simulation model. The exercise in this section shows you how to use
the Constraint Navigator controls to check your exported model. Refer to
Figure 5-52.

Figure 5-52
Constraint Navigator

When MSC.visualNastran Desktop exports the CAD model, it creates joints
between parts of the assembly. The types of joints created depends on the
constraints and geometry of the CAD model. 

If the joints that MSC.visualNastran Desktop creates are not given the
appropriate degrees of freedom, the parts cannot move appropriately when
you run the simulation. To correct this problem, you should verify and adjust
the joints between the parts of the assembly as necessary to correctly
specify the motion desired.

 In the steps that follow, you will adjust the joints to give each the appropriate
degrees of freedom.

1. Click the Next Constraint button.

Concentric1, a revolute constraint, is isolated as shown in Figure 5-53.

Figure 5-53
Isolated Constraint
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2. Click the Move button in the Constraint Navigator, click over the Crank,
and drag the mouse.

This tests the kind of movement allowed by the constraint. This constraint
is OK.

3. Click the Next Constraint button.

Concentric2, another revolute joint, is isolated.

4. Use the Move tool to test the constraint by first moving the crank and
then moving the crank pin.

The model requires a rigid connection between CRANK PIN-1 and Crank-
1. That means changing this revolute joint into a rigid joint. 

5. Double-click the Concentric2 revolute constraint in the Connections
List.

The Properties window appears as shown in Figure 5-54.

Figure 5-54
Properties Window (Constraint 
Page) 

6. Click the Rigid Joint on the Constraint page of the Properties
window.

7. Under the Rigid tab of the Properties window, accept the Optimized
setting.

This combines the mass properties of the two connected bodies and
computes the motion as if they were one body. Unless the constraint force
is to be measured, optimized rigid joints should always be used because
they improve simulation computational speeds.
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8. Close the Properties window.

9. Click the Next Constraint button.

Distance3, a revolute joint on plane, is isolated.

10. Choose Look At in the View menu, then choose Top View in the View
submenu.

This provides a better view of the constraint.

11. Use the Move tool to test the constraint.

This model requires deleting this constraint and its two Coords.

12. Hold down the Control key and select in the Connections List
coord[23] on Crank-1 and coord[25] on CONNECTING ROD-1, the
two Coords connected to Distance3.

The rigid joint, Distance3, as well as its two Coords should be selected
when you are done.

13. Press the delete key.

The MSC.visualNastran Desktop dialog appears to inform you that you
are deleting an object linked to a CAD assembly.

14. Click OK.

15. Choose Look At in the View menu, then choose Previous View in the
View submenu.

16. Click the Next Constraint button.

Concentric3, a revolute joint on slot, is isolated.

17. Use the Move tool to test the constraint.

The model requires changing this constraint to a revolute joint.

18. Double-click Concentric3 in the Connections List.

The Properties window appears. Click the Constraint tab if the Constraint
page is not already displayed. 

19. Select Revolute Joint in the Constraint page of the Properties
window.

This changes the constraint.
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20. Close the Properties window.

21. Click the Next Constraint button.

Parallel1, a parallel joint, is isolated.

22. Choose Look At in the View menu, then choose Right View in the
View submenu.

This provides a better view of the constraint.

23. Use the Move tool to test the constraint.

This model requires deleting this constraint and its two Coords.

24. Hold down the Control key and select in the Connections List
coord[31] on Crank-1 and coord[33] on CONNECTING ROD-1, the
two Coords connected to Parallel1.

The rigid joint, Parallel1, as well as its two Coords should be selected when
you are done.

25. Press the delete key.

The MSC.visualNastran Desktop dialog appears to inform you that you
are deleting an object linked to a CAD assembly.

26. Click OK.

27. Choose Previous View in the View menu.

28. Click the Next Constraint button.

Concentric4, a revolute joint, is isolated.

29. Use the Move tool to test the constraint.

The model calls for an optimized rigid joint here.

30. Double-click the Concentric4 revolute constraint.

The Properties window appears.

31. Click Rigid Joint on the Constraint page of the Properties window.

32. Under the Rigid tab of the Properties window, accept the Optimized
setting.

33. Close the Properties window.
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34. Click the Next Constraint button.

Parallel2, a parallel joint, is isolated.

35. Use the Move tool to test the constraint.

This model requires deleting this constraint and its two Coords.

36. Hold down the Controlkey and select in the Connections List
coord[39] on Crank-1 and coord[41] on Crank-2, the two Coords
connected to Parallel2.

The rigid joint, Parallel2, as well as its two Coords, should be selected when
you are done.

37. Press the Delete key.

The MSC.visualNastran Desktop dialog appears to inform you that you
are deleting an object linked to a CAD assembly.

38. Click OK.

39. Click the Next Constraint button.

Concentric5, a revolute joint, is isolated.

40. Use the Move tool to test the constraint.

This joint is OK.

41. Click the Next Constraint button.

Concentric6, a revolute joint, is isolated.

42. Use the Move tool to test the constraint.

The model requires changing this constraint to an optimized rigid joint.

43. Double-click the Concentric6 revolute constraint.

The Properties window appears.

44. Click Rigid Joint on the Constraint page of the Properties window.

45. Under the Rigid tab of the Properties window, accept the Optimized
setting.

46. Close the Properties window.
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47. Next, you can step through each body by clicking on the Next and
Previous Body buttons in the Constraint Navigator to verify body
motion.

48. Click Done to close the Constraint Navigator.

Anchored Assemblies — SolidWorks

NOTE: If a body is “fixed” in SolidWorks, it will be anchored in
MSC.visualNastran Desktop. If a body “floats” in SolidWorks, it will not be
anchored in MSC.visualNastran Desktop. By default, SolidWorks “fixes” the
first body brought into an assembly.

The first step in simulating the motion of the piston assembly is to make sure
that it is properly anchored. 

• If no bodies in the assembly are anchored, the piston is floating in
space and gravity will cause it to fall when you run the simulation. 

• If too many bodies are anchored, the piston won’t be able to move
appropriately when you run the simulation.

When MSC.visualNastran Desktop imports the piston assembly from
SolidWorks, it anchors the bodies appropriately. No modifications are
necessary. You are ready to run an initial simulation in MSC.visualNastran
Desktop.

1. Click the Run button in MSC.visualNastran Desktop’s Tape Player 
Control, and let the simulation run for about 100 frames.

MSC.visualNastran Desktop begins to simulate the motion of the model.
The piston assembly balances at first, then the piston head falls under the
effect of gravity. Since the piston is almost in equilibrium, you will not see
any movement at first. 

The geometry of the assembly causes the piston head to swing like a
pendulum around the crank pin, which is held in place by the anchor, as
shown in Figure 5-55. 
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Figure 5-55
Piston Head Swinging Around 
the Crank Pin Like a Pendulum 

Since this is the first time the simulation is being run, MSC.visualNastran
Desktop calculates the dynamics and stores the data. 

2. Repeat the simulation by clicking the Stop button, then the Reset
button, and then the Run button again.

Depending on the speed of your computer, the animation may be faster this
time because the history has already been calculated.

Adding a Motor — SolidWorks
Currently, the piston assembly is moving only in response to the effects of
gravity. In this step, you will change the joint between the anchor and left
side of the crank to a motor that drives the motion of the piston. The motor
applies a torque to the crank.

1. Click on ANCHOR-1 in the Object List.

The Connections List displays a list of the objects connected to this body.

2. Double-click Concentric1, the revolute joint that connects ANCHOR-
1 to CRANK-1.

The Properties window for Concentric1 appears.

3. If necessary, click the Constraint tab in the Properties window. Then,
select Revolute Motor from the list of available joint types, as shown
in Figure 5-56.

The revolute joint is changed into a revolute motor. 
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Figure 5-56
Properties Window 
(Constraint Page) for Revolute 
Motor

4. Click the Motor tab.

This displays the Motor page of the Properties window.

5. Accept Angular Velocity in the list of Motor Types.

6. Enter 500 as the value for angular velocity of this Revolute Motor, as 
shown in Figure 5-57.

You can close the Properties window now.

Figure 5-57
Properties Window 
(Motor Page)

7. Click the Run button in MSC.visualNastran Desktop’s Tape Player 
Control.

The piston assembly rotates all the way around the crank pin, as shown in
Figure 5-58. It no longer swings like a pendulum, because the motor
provides the driving force to keep the piston rotating. 
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Figure 5-58
Piston Head Rotating All the 
Way Around the Crank Pin 

8. Click the Stop button.

Adjusting the Joints — SolidWorks
In this step, you will add a new constraint that limits the motion of the piston
head, so that it can only move vertically.

1. Reset the simulation by clicking the Reset button.

The piston assembly returns to its starting position.

2. Press “Z” on the keyboard, or choose Look At in the View menu and
choose Top View in the submenu. 

3. Click the Rotate Around tool in the View toolbar or press “T” on the
keyboard so that you can see the top of the piston head and the rest of
the drawing.

Your view should be similar to Figure 5-59. 
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Figure 5-59
Top of the Piston Head

4. Click the Coord tool in the Edit toolbar, then place a Coord on the top
surface of the piston head, near the center.

Blue lines appear around the piston head and cranks. This feature
recognition helps guide placement of the Coord. The z-axis of the Coord
should point upward and its red outline surrounds the top center of the
piston head.

5. Make sure that the Coord that you just created is selected.  Then click
the Join/Create Constraint button in the Edit toolbar.

The Create Constraint window appears.

6. Select Rigid Joint on Slot from the list of available constraint types,
as shown in Figure 5-45, and click Create.

A rigid joint on slot appears on top of the piston head. This constraint
connects the piston head to the background and allows the piston head to
move only in the vertical (z-axis) direction. 
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Figure 5-60
Create Constraint Window

 

7. Choose Go Home in the View menu.

Your original view of the piston assembly (which provides a better view of
the motion) is restored. 

8. Click the Run button in MSC.visualNastran Desktop’s Tape Player 
Control.

The piston head is pushed up and pulled down by the connecting rod as the
crank rotates about the crank pin, as shown in Figure 5-46.

Figure 5-61
Piston Head Pushed Up and 
Pulled Down by the Connecting 
Rod

9. Click the Stop button.

Your model of the motion of the piston assembly is now complete!
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Using CAD Associativity — SolidWorks
You’ve put a lot of work into adapting the CAD model to accurately simulate
the motion of the piston assembly. What happens if the CAD model
changes? 

When you re-export the CAD model, any changes to it are automatically
incorporated into your simulation of the motion. All of the changes and
enhancements that you have already made in the simulation are left
unchanged. 

Change the Connecting Rod 
Length and Re-export the 
CAD Model

In this step, you will re-export the model to MSC.visualNastran Desktop.
When you return to MSC.visualNastran Desktop, the changes you made will
automatically be incorporated into your simulation of the motion.

1. Reopen the Piston model in your CAD software.

2. Change the length of the Connecting Rod part from 150 mm to 250 
mm.

If needed, refer to your CAD software User’s Manual or online help for
instructions on how to change the length of the connecting rod part.

3. Choose Connect in the MSC.visualNastran menu.

MSC.visualNastran Desktop for SolidWorks re-exports the piston assembly
components and constraints. When the process is done, the
MSC.visualNastran Desktop program reopens the linked model, as shown
in Figure 5-62.
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Figure 5-62
Changes in the SolidWorks 
CAD Model Reflected in 
MSC.visualNastran Desktop 

Your changes to the CAD model are reflected in MSC.visualNastran
Desktop. The length of the connecting rod has been changed.

4. Click the Run button in MSC.visualNastran Desktop’s Tape Player 
Control.

Your simulation of the motion of the piston assembly runs with no problems.

5. Click the Stop button.

MSC.visualNastran Desktop preserves and protects your enhancements to
the simulation model, while giving you the flexibility to change the
underlying geometry of the CAD model as needed.

Using Sub-Assemblies — SolidWorks
You can use MSC.visualNastran Desktop’s sub-assembly feature to help
organize your design.

1. Choose Sub-assembly in the Insert menu.

The Create Sub-assembly dialog appears.

2. Enter Crank Parts in the text region of the Sub-assembly dialog.

The Crank Parts sub-assembly is added to the Object List.
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3. In the Object List, drag and drop the Anchor, both Cranks, and the 
Crank Pin into the sub-assembly.

The drawing is unchanged by the re-organized Object List.

Exercise 5.5 Exploring Autodesk Inventor Integration 
and Associativity

Objectives In this exercise you will learn to 

• Export a CAD model from Autodesk Inventor.
• Verify and modify your simulation model using the Constraint 

Navigator.
• Change a constraint to a motor and add new constraints.
• Use CAD Associativity.
• Organize your design using subassemblies.

Software • MSC.visualNastran 4D or MSC.visualNastran Motion
• Autodesk Inventor

Support Files • Tutorials\Chapter 5\Exercise 5.5-Inventor\Piston.iam

Exporting a CAD Model — Autodesk Inventor

1. Launch Autodesk Inventor.

MSC.visualNastran Desktop for Autodesk Inventor prompts you to view a
tutorial overview.  This happens only the very first time you open Autodesk
Inventor with MSC.visualNastran Desktop’s Autodesk Inventor Integration
installed.  You can work through the tutorial now or at a later time.

2. Open the file Piston.iam located in your Program
Files\MSC.visualNastran Desktop\Tutorials\Chapter 05\Exercise
5.5- Inventor folder. 

The CAD model of the piston assembly is displayed as shown in Figure 5-
63.

3. From the Tools menu, select MSC Analysis Tools.  Select Connect
to MSC.visualNastran Desktop... from the submenu.  (See Figure 5-
64).
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Figure 5-63
Inventor CAD Model of Piston 
Assembly

Figure 5-64
MSC Analysis Tools Menu in 
Inventor

MSC.visualNastran Desktop for Autodesk Inventor maps the assembly
components and constraints into MSC.visualNastran Desktop bodies and
joints, and creates a new, linked model named Piston.wm3 in the directory
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where the CAD files are located. As MSC.visualNastran Desktop translates
the geometry, the progress is displayed in the Preparing Simulation
dialog.

When the export is complete, the MSC.visualNastran Desktop program
opens and displays the CAD Associativity dialog, listing the
MSC.visualNastran Desktop objects that are associated with objects in the
Inventor model as shown in Figure 5-65.

Figure 5-65
CAD Associativity Dialog

 

4. Click OK to close the CAD Associativity dialog.

MSC.visualNastran Desktop prompts you to run the Constraint Navigator. 

5. Click Yes to run the Constraint Navigator.

The linked model appears with the Constraint Navigator in the modeling
window.
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Using the Constraint Navigator — Autodesk Inventor
The Constraint Navigator allows you to examine relationships among
bodies, subassemblies, and constraints so that you can verify and modify
your simulation model. The exercise in this section shows you how to use
the Constraint Navigator controls to check your exported model. Refer to
Figure 5-66.

Figure 5-66
Constraint Navigator

When MSC.visualNastran Desktop exports the CAD model, it creates joints
between parts of the assembly. The types of joints created depends on the
constraints and geometry of the CAD model. 

If the joints that MSC.visualNastran Desktop creates are not given the
appropriate degrees of freedom, the parts cannot move appropriately when
you run the simulation. To correct this problem, you should verify and adjust
the joints between the parts of the assembly as necessary to correctly
specify the motion desired.

In the steps that follow, you will adjust the joints to give each the appropriate
degrees of freedom.

1. Click the Next Constraint button.

A revolute joint, Insert11, is isolated as shown in Figure 5-67.

Figure 5-67
Isolated Constraint

Help

Quit
Step Through
Constraints

Step Through
Bodies

Toggle
Wireframe

Move
Object
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2. Click the Move button in the Constraint Navigator, click over the
Crank, and drag the mouse.

This tests the kind of movement allowed by the constraint. The constraint is
OK.

3. Click the Next Constraint button.

A revolute joint, Mate02, is isolated.

4. Use the Move tool to test the constraint by first moving the crank and
then moving the crank pin.

The model requires a rigid connection between CRANKPIN_1 and
CRANK_1.  That means changing this revolute joint into a rigid joint. 

5. Double-click Mate02 in the Connections List.

The Properties window appears as shown in Figure 5-68.

Figure 5-68
Properties Window (Constraint 
Page) 

6. Click the Rigid Joint on the Constraint page of the Properties
window.

7. Under the Rigid tab of the Properties window, accept the Optimized
setting. 

This combines the mass properties of the two connected bodies and
computes the motion as if they were one body. Unless the constraint force
is to be measured, optimized rigid joints should always be used because
they improve simulation computational speeds.

8. Close the Properties window.



5-70 Chapter 5—Exploring CAD Integration and Associativity
9. Click the Next Constraint button.

A revolute joint on slot, Mate05, is isolated.

10. Use the Move tool to test the constraint.

This model requires changing the constraint to a revolute joint.

11. Double-click Mate05 in the Connections List.

12. Select Revolute Joint in the Constraint page of the Properties
window.

13. Close the Properties window.

14. Click the Next Constraint button.

A revolute joint on plane, Mate03, is isolated.

15. Use the Move tool to test the constraint.

The model requires deleting this constraint and its two coords.

16. Hold down the Control key, and in the Connections List, select the
two coords connected to Mate03.

17. Press the delete key.

A dialog appears to warn you that you are deleting an object linked to a CAD
assembly.

18. Click OK.

19. Click the Next Constraint button.

A revolute joint, Mate07, is isolated.

20. Use the Move tool to test the constraint.

The model requires changing this constraint to a rigid joint.

21. Double-click Mate07 in the Connections List.

22. Select Rigid Joint in the Constraint page of the Properties window.

23. Close the Properties window.

24. Click the Next Constraint button.
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A revolute joint on plane, Flush04, is isolated.

25. Use the Move tool to test the constraint.

The model requires deleting this constraint and its two coords.

26. Hold down the Control key, and in the Connections List, select the
two coords connected to Flush04.

27. Press the delete key.

28. Click OK.

29. Click the Next Constraint button.

A revolute joint on slot, Mate08, is isolated.

30. Use the Move tool to test the constraint.

This model requires changing this constraint to a revolute joint.

31. Double-click Mate08 in the Connections List.

32. Select Revolute Joint in the Constraint page of the Properties
window.

33. Close the Properties window.

34. Click the Next Constraint button.

A revolute joint, Mate10, is isolated.

35. Use the Move tool to test the constraint.

This constraint is OK.

36. Next, you can step through each body by clicking on the Next and
Previous Body buttons in the Constraint Navigator to verify body
motion. 

37. Close the Constraint Navigator by clicking the Done button.

Anchored Assemblies — Autodesk Inventor
Based on the constraints and geometry in the Autodesk Inventor CAD
model, MSC.visualNastran Desktop may anchor some parts to the
background when it creates the linked model. The first step in simulating the
motion of the piston assembly is to make sure that it is properly anchored. 
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• If no bodies in the assembly are anchored, the piston is floating in
space and gravity will cause it to fall when you run the simulation. 

• If too many bodies are anchored, the piston won’t be able to move
appropriately when you run the simulation.

In this piston assembly, ANCHOR_1 is fixed.

1. Click the Run button in MSC.visualNastran Desktop’s Tape Player
Control.

There is no movement. This is because gravity is acting in the “wrong”
direction. By default, gravity acts on the z axis in MSC.visualNastran
Desktop, specifically in the “-z” direction. If the z-axis was not in an upward
orientation when the CAD assembly was created, then the direction of
gravity must be changed before MSC.visualNastran Desktop can properly
simulate the motion.

2. Use the Tape Player Control to stop and reset the simulation.

3. Choose Simulation Settings in the World menu.

The Simulation Settings window appears. 

4. Click Gravity under Simulation Settings in the left pane of the 
window.

The Gravity page appears as shown in Figure 5-69.

Figure 5-69
Settings Window (Gravity Page) 
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5. Under Gravity Direction and Magnitude, select the radio button for 
the “-X” direction.

6. Click Close.

7. Click the Run button in MSC.visualNastran Desktop’s Tape Player 
Control.

MSC.visualNastran Desktop begins to simulate the motion of the model.
The piston assembly balances at first, and then the piston head falls under
the effect of gravity.  Since the piston is almost in equilibrium, you will not
see any movement at first.  You will begin to see movement after the
simulation runs 120 frames. 

The geometry of the assembly causes the piston head to swing like a
pendulum around the crank pin, which is held in place by the anchor, as
shown in Figure 5-70. 

Figure 5-70
Piston Head Swinging Around 
the Crank Pin Like a Pendulum 

Since this is the first time the simulation is being run, MSC.visualNastran
Desktop calculates the dynamics and stores the data. 

8. Repeat the simulation by clicking the Stop button, then the Reset
button, and then the Run button again.

Depending on the speed of your computer, the animation may be faster this
time because the history has already been calculated.

9. Click the Stop button.
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Adding a Motor — Autodesk Inventor
Currently, the piston assembly is moving only in response to the effects of
gravity. In this step, you will change the joint between the anchor and left
side of the crank to a motor to simulate the force that drives the motion of
the piston. 

1. In the Object List, click ANCHOR_1.

2. In the Connections List, double-click Insert11, the revolute joint that
connects ANCHOR_1 to CRANK_1.

The Properties window for Insert11 appears.

3. If necessary, click the Constraint tab in the Properties window. Then,
select Revolute Motor from the list of available joint types, as shown
in Figure 5-71.

The revolute joint is changed into a revolute motor. 

Figure 5-71
Properties Window 
(Constraint Page) for Revolute 
Motor

4. Click the Motor tab in the Properties window.

This brings up the motor characteristics page.

5. Accept Angular Velocity in the list of Motor Types.

6. Enter 500 as the value for angular velocity of this Revolute Motor, as 
shown in Figure 5-72.

You can close the Properties window now.
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Figure 5-72
Properties WIndow 
(Motor Page)

7. Click the Run button in MSC.visualNastran Desktop’s Tape Player 
Control.

The piston assembly rotates all the way around the crank pin, as shown in
Figure 5-73. It no longer swings like a pendulum, because the motor
provides the driving force to keep the piston rotating. 

Figure 5-73
Piston Head Rotating All the 
Way Around the Crank Pin 

8. Click the Stop button.

Adjusting the Joints — Autodesk Inventor
In this step, you will add a new constraint that limits the motion of the piston
head, so that it can only move vertically.

1. Reset the simulation by clicking the Reset button.
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The piston assembly returns to its starting position.

2. Press “X” on the keyboard, or choose Look At in the View menu and 
choose Front View in the submenu. 

3. Click the Rotate Around tool in the View toolbar and rotate the model 
so that you can see the top of the piston head and the rest of the 
drawing.

Your view should be similar to Figure 5-74. 

Figure 5-74
Top of the Piston Head

4. Click the Coord tool in the Edit toolbar, then place a Coord on the top
surface of the piston head, near the center.

Blue lines appear around the piston head and cranks. This feature
recognition helps guide placement of the Coord. When you place the Coord
on the blue circular outline on top of the piston head, it automatically snaps
to the center of the piston head. The z-axis of the Coord should point
upward and its red outline surrounds the top center of the piston head.

5. Make sure that the Coord that you just created is selected.  Then click
the Join/Create Constraint button in the Edit toolbar.

The Create Constraint window appears.

6. Select Rigid Joint on Slot from the list of available constraint types,
as shown in Figure 5-75. Then click Create.
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A rigid joint on slot appears on top of the piston head. This constraint
connects the piston head to the background and allows the piston head to
move only in the vertical direction. 

Figure 5-75
Create Constraint Window

 

7. Choose Go Home in the View menu.

Your original view of the piston assembly (which provides a better view of
the motion) is restored. 

8. Click the Run button in MSC.visualNastran Desktop’s Tape Player 
Control.

The piston head is pushed up and pulled down by the connecting rod as the
crank rotates about the crank pin, as shown in Figure 5-76.

Figure 5-76
Piston Head Pushed Up and 
Pulled Down by the Connecting 
Rod

9. Click the Stop button.
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Your model of the motion of the piston assembly is now complete!

Using CAD Associativity — Autodesk Inventor
You’ve put a lot of work into adapting the CAD model to accurately simulate
the motion of the piston assembly. What happens if the CAD model
changes? 

When you re-export the CAD model, any changes to it are automatically
incorporated into your simulation of the motion. All of the changes and
enhancements that you have already made in the simulation are left
unchanged. 

Change the Connecting Rod 
Length and Re-export the 
CAD Model

In this step, you will change the piston in Autodesk Inventor and re-export
the model to MSC.visualNastran Desktop. When you return to
MSC.visualNastran Desktop, the changes you made will automatically be
incorporated into your simulation of the motion.

1. Reopen the Piston model in your CAD software.

2. Change the length of the Connecting Rod part from 150 mm to 250 
mm.

If needed, refer to your CAD software User’s Manual or online help for
instructions on how to change the length of the connecting rod part.

3. Choose Tools>MSC Analysis Tools>Connect to 
MSC.visualNastran Desktop....

MSC.visualNastran Desktop for Autodesk Inventor re-exports the piston
assembly components and constraints. When the process is done, the
MSC.visualNastran Desktop program reopens the linked model, as shown
in Figure 5-77.
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Figure 5-77
Changes in the Inventor CAD 
Model Reflected in 
MSC.visualNastran Desktop 

Your changes to the CAD model are reflected in MSC.visualNastran
Desktop. The length of the connecting rod has been changed.

4. Click the Run button in MSC.visualNastran Desktop’s Tape Player
Control.

Your simulation of the motion of the piston assembly runs with no problems.

5. Click the Stop button.

MSC.visualNastran Desktop preserves and protects your enhancements to
the simulation model, while giving you the flexibility to change the
underlying geometry of the CAD model as needed.

Using Sub-Assemblies — Autodesk Inventor
You can use MSC.visualNastran Desktop’s sub-assembly feature to help
organize your design.

1. Choose Sub-assembly in the Insert menu.

The Create Sub-assembly dialog appears.

2. Enter Crank Parts in the text region of the Sub-assembly dialog and 
click OK.

The Crank Parts sub-assembly is added to the Object List.
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3. In the Object List, drag and drop the Anchor, both Cranks, and the 
Crank Pin into the sub-assembly.

The drawing is unchanged by the re-organized Object List.


